
Installing and Starting the Through the Breach Module

Go to vassalengine.org and download and install the latest version of the Vassal program for your 
system. Next you will need the latest version of the Through the Breach module, you will find a link to it 
on our website.

Start Vassal and Open the module. 

The first option you will get will be whether you want to ' Start a new game offline', 'Look for a game 
online' or 'Load saved game'

Most of the time you will want to 'Look for a game online', but you may want to start offline if  you are 
just putting together your Twist Deck for a game later in the week.

If you are the first player online you will need to create a room for your game. To do this enter a name 
for your game in the New Game field 1. Once in the game select New Game2 from the File menu.

Choose Your Role

When Loading the Through the 
Breach Vassal module the first 
choice you have to make is which 
role you are going to take. If you 
are the Fatemaster, choose the 
Fatemaster option. If you are a 
player, choose one of the eight 
available  seats (The Fool, The 
Magician, The High Priestess, The
Hierophant, The Hermit, The 
Hanged Man, Death, or Justice).



Each of the seats has its own sideboard
where the player can keep their Twist 
Deck. There is also a communal Fate 
Deck which is available to the 
Fatemaster and every player. To open 
the windows containing a player’s 
Twist Deck or the communal Fate Deck,
click on the Decks button in the Main 
Toolbar, then click on the Deck you 
want to view.

Creating a Twist Deck

When you first open your seat’s sideboard, it will be empty. To create your Twist Deck, click on the 
Cards1 button in the Main Toolbar. This opens a window containing copies of all the available cards for 
every suit. Just drag the cards you need for your twist deck from this menu into your seats sideboard to 
add it to your Twist Deck2. When a card is dragged to an seat’s sideboard, an icon will appear in the top 
right corner of the card, and the back of the card will change to match your seat. 



If you wish to know which cards are currently in your Twist Deck, you can click the Deck Lists1 button in 
the Main Toolbar to view its contents2.

Using a Twist Deck

To draw a card from your Twist Deck, simply click the top of your Twist Deck and drag the card to the 
side. You will see that it has a dark border around it and the word “Hidden” across its bottom left 
corner1. This means that the other players cannot see the card in question. To reveal a hidden card, 
either select it and press [Ctrl+F], right click it and select Flip2. You can also drag the card onto the Fate 
Deck's board before you reveal it so that all players may see it.



If you drag a Twist Card to the Fate Deck discard pile, it will automatically return to your Twist Deck’s 
discard pile in your seat sideboard.

There are four buttons at the top of an seat’s sideboard. 

The first one takes all of the cards in the discard pile and shuffles them back into the Twist
Deck. 

The second button unassigns all of the cards in your sideboard. This is primarily only used 
when you are loading a saved deck that had a different seat than your current seat (which
will be explained in more detail below).

The third button moves all of the cards not currently in the Draw Deck into the discard 
pile.

The fourth button deletes all of the cards in the seat’s sideboard. 

Saving Your Twist Deck

A Twist Deck can be saved for future sessions, allowing you to load it back up at the start of your next 
game. To save a Twist Deck, right click on the Twist Deck and select the “Save”1 option. To load a saved 
Twist Deck, right click on the Twist Deck space and select the “Load” option. 



When a deck is loaded, it will retain its previous seat. If your current seat is different from that of your 
Twist Deck, click the Unassign button at the top of your seat sideboard to remove the seat from the 
cards, select all the cards by holding shift and dragging over the card pile, then drop them into the 
Discard Pile of the sideboard you want them linked to.

The Fate Deck

When a Fate Deck is first loaded, it will be unshuffled. To shuffle the Fate Deck, right click on it and 
select the Shuffle1 option, or select the Reshuffle2 button from the top of the Fate Deck screen.

There are four buttons3 at the top of the Fate Deck screen that will flip the indicated number of cards off
the top of the Fate Deck when they are pushed. 

The final Discard4 button on the Fate Deck screen moves all of the flipped cards to the discard pile. 



Additional Controls

This button opens up a menu that can be used to keep notes that can been 
seen by every player. You can also create notes that can be locked and reveal 
them at a later time.

This button opens up a map that can be used to track relative location 
between the Fated characters and their adversaries. Fatemasters can create a 
map before the game, save it from the File menu in the upper left corner, and 
then load it back up again when the game begins. The players can load their 
Twist Decks once the map is loaded.

This button opens a menu containing a collection of models and objects that 
Fatemasters might fight useful when populating a map.



The Map

Models
The Through the Breach module includes a map that can be used to track movement, auras, wounds, 
and general positioning during your game. Many actions can be accessed by right-clicking on a 
model, and almost all the controls have a keyboard shortcut.

Anatomy of a Model

The image above shows the Dead Rider model. The models in the Through the Breach module are on 
various size bases and have a colored rim that matches one of the Malifaux factions, in this case green 
for the Resurrectionists. Each model's name can be changed by right clicking the model, choosing 
"Model" from the menu, and then choosing "Change Label" from the submenu. Models can also be 
used to track status effects and wounds, that may be added to them. In the example above, the Dead 
Rider has received two wounds, is paralyzed (the red box), and has Poison +1 (the green glob).

Choosing Models

A menu containing models can be opened by clicking the Map Objects button in the main toolbar. To 
place a model on the map or to quickly move a model from one map location to the next, left-click the 
model and drag it to the desired area. Multiple models may be selected at once by either left-clicking 
on the map and holding the mouse button down as you drag a targeting box over the desired models 
or by performing a SHIFT + left-click on each model you wish to select.



Moving a Model

Each model may be moved by either dragging it to a desired location (usually after measuring a distance 
with the ruler) or by using keyboard shortcuts (which are also available via the right-click menu in the 
"Movement" submenu). To move a model via keyboard shortcuts, first select it by left-clicking on it, 
then input the desired movement keys: 

Move forward 1"

Move backward 1"

Rotate counterclockwise 10º

Rotate clockwise 10º

Move forward ½"

Move backward ½"

Rotate counterclockwise 5º

Rotate clockwise 5º

Nudge in any direction

Each model has a small arrow on the rim of its base which denotes the direction it is facing. When a 
model is moved forward, it moves in the direction indicated by this arrow, with the exception of 
Nudge movements. When a model is Nudged, it moves a slight distance in the indicated direction 
without changing its orientation.



Marking Wounds

Models can be marked to show how much damage they have suffered. This can be particularly 
useful for Fatemasters who are tracking multiple combatants and for players who are debating 
which of their allies needs healing!

Add Wound

Remove Wound

1” Transparent Aura

to 

(Toggle)

2” to 10” Transparent 
Aura (Toggle)

1” Shaded Aura
(Toggle)

2” to 10” Shaded Aura 
(Toggle) to 

Auras and Melee Ranges
Models can be given an aura to see whether another model is within a certain range of something, 
such as an attack or an Aura effect. These auras travel with the model and are represented by a 
circular shaded region of the appropriate size. A model may have multiple auras activate at a given 
time. Auras can be toggled on and off by right-clicking the model and selecting the appropriate aura 
range from the Aura submenu, or by using the following keyboard shortcuts:



Raise Burning

Lower Burning

Raise Poison

Lower Poison

Raise Blight

Lower Blight

Fast  / Slow 
(Toggle)

Reactivate  / 
Paralyzed      
(Toggle)

Cloning Models
Models may be copied (or "cloned"), which creates a copy of the model on top of the original. This 
can be done by right-clicking the model, selecting "Model," and then selecting "Clone" from the 
submenu, or by using keyboard shortcuts:

Tracking Conditions
Models can also be used to track some common Conditions. These can be accessed by right-clicking 
on the model and opening the Status or Extra Conditions menus. For Conditions that stack (such as 
Burning or Poison), the first instance of the Condition is represented by an icon. As the Condition 
increases above +1, numbers representing the value of the Condition will appear inside the 
appropriate icon. 

Some Conditions can also be adjusted via keyboard shortcuts:

Copy/Clone a model



Kill a model
(and leave counters)

Delete a model (leaving 
no counters)

Killing Models
Models may be killed or deleted from the map when they are no longer needed. Killing a model leaves 
the appropriate counters for that model (which may be either a corpse or scrap, depending upon the 
model in question). Deleting a model removes it from play without leaving any counters behind. 

A model's rim colors can be changed to differentiate similar models from one another. Rim colors 
maybe changed by right-clicking a model and selecting "Rims" from the menu, or via keyboard 
shortcuts:

Next Rim

Previous Rim

Additionally, be right-clicking a model and selecting "Markers" from the menu, you can surround a 
model with a glowing effect in a certain color. This is a great way to track which models have activated 
in a round and which have not; just turn off a model's Marker as its character completes its turn!

If multiple models are selected, then you can change all of their rims or give them all Markers at the 
same time.



Making Maps
This quick tutorial will run you through the steps needed to create maps using the Through the Breach 
module. Once you are happy with your map, you can save it using the File command on the main toolbar.

First, start a game (either offline or online) and open the map. You'll be presented with a blank desert 
map with no terrain, but if you click the "Change Map" button in the upper left corner of the map, it will 
toggle between a water map (which is good for creating Bayou terrain) and a darker city map. 

To add terrain to your map, click the "Map Objects" button on the main toolbar and select the "Terrain" tab. 
Choose the terrain object you want from the various drop down menus and then drag them onto your map 
to place them. It's recommended that you start with larger objects such as hills and buildings and then place 
smaller objects like scattered barrels or crates around them.

Once you have placed a piece of terrain on the map it is possible to move it around, rotate it, or nudge it 
into the correct position. Terrain is designed to be difficult to accidentally select, so if you wish to move 
terrain after it's been placed, hold down the SHIFT button as you left-click on it to select it. Terrain can 
be moved or altered with the following keyboard shortcuts:

Rotate counterclockwise 10º

Rotate clockwise 10º

Rotate counterclockwise 5º

Rotate clockwise 5º

Nudge in any direction

Rotate freely

Copy/Clone Terrain

Delete Terrain



Layers

Layers determine which terrain pieces sit on top of other terrain pieces. The higher a terrain piece's 
Layer, the closer to the "top" it will be in a stack of terrain. You can change the Layer of a terrain piece 
by selecting it and pressing F1, which will bring up a pull down menu from where you can set the 
terrain piece's new layer.

Open Layer menu

In the left picture, you can see the Tree sits on top of the Platform, This is because the Platform is on 
Layer 4 while the Tree is on Layer 7. By changing the Tree to Layer 2, the Platform moves to the "top" 
of the stack and now sits on top of the Tree.



Terrain Markers
Since Vassal uses a top-down viewpoint, it sometimes becomes important to know the height of a 
tree, building, or similar piece of terrain. To help with this, the Through the Breach module includes 
Terrain Markers. These markers come in multiple colors to designate Soft Cover, Hard Cover, 
Hazardous terrain, and Impassible terrain. 

The Terrain Markers can be found in the Map Objects menu under the Terrain tab. To use them, left-
click a Terrain Marker and drag it onto a terrain piece. The Markers are on Layer 9, so they will show 
up above all other terrain pieces. To set the indicated height of a Terrain marker, use the B and N 
keys while the Terrain Marker is selected.

In this example, the Barrels and Rocks count as Hard Cover, the Hill is Ht 3, the Trees are Obscuring and Ht 4, 
The Lava has no Ht but is Hazardous Dg 1/2/3 and lastly the Silo isImpassible.

Increase Ht

Decrease Ht

Copy/Clone Marker

Delete Marker

Change Hazardous Dg

It is possible to hide all the Terrain Markers by pressing the  Button on the Control Hub.able Terrain



Breakable Terrain

Some pieces of terrain are Breakable these are denoted by a (b) after their name in the Terrain Panel. Some 
of the walls/stairs of breakable terrain can be destroyed. To find out which walls can be destroyed select the 
piece of terrain and press Ctrl + H to bring up the Key, breakable walls will be shaded red and have a number, 
to destroy them press Ctrl + the number shown.

Show Key

Destroy Wall/Stairs
(Toggle) to 
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